Mill One V2
Assembly Manual




Throughout this policy the words "we", "us" and "our", or “Sienci Labs” will be used to refer to Sienci Labs Inc. herein and
“Mill One” or “machine” will refer to Sienci Labs’ Sienci Mill One product. Additionally, the words "you", "your", “user”,
and “operator” will refer to the original purchaser/customer, user, or viewer of any of the products or media provided by

or through Sienci Labs.

Machine Disclaimer

The listed “Safety Warnings and Guidelines” outline the necessary precautions that should be taken any time the
machine is operated. By assembling our provided kit, the product user takes on all the associated liability pertaining to
the operation and maintenance of the Mill One. Sienci Labs will not be held responsible for any damages to property or
injury incurred on the operator or bystanders if any alterations are made to the design or assembly of our machine.
Although care is taken to ensure the accuracy of information made available on our website (www.Sienci.com) and other
forms of media, Sienci Labs will not be held liable for any inaccuracies, errors, or inconsistencies in website content, the
content of files linked to by our website, references made to external websites herein, and/or other information
produced by Sienci Labs. The information which has been made available will not be applicable to all situations and is
subject to change without notice so it should not substitute for the discretion of the user. Variability in machine accuracy
and performance may occur due to improper machine assembly by the user, as such, Sienci Labs takes on no
responsibility for variation between claimed machine specifications and the performance of the user’s machine from
improper assembly.

Safety Warnings and Guidelines

1. Besure to carefully follow provided machine assembly instructions before machine use to ensure operator
safety.

2. Allwires must be appropriately positioned before beginning the operation of this machine. Cutting a “live” wire

may cause exposed metal parts of the routing/trimming tool to become electrified and shock the operator.

Ensure the machine is placed on a flat surface and in a well-ventilated space before operation.

Always wear eye protection during machine operation.

Always wear hearing protection during extended machine operation based on proximity to machine.

Materials may release chemicals that are toxic or unsafe to inhale when cut. Always check the Material Safety

Data Sheet (MSDS) of the material in question before cutting. Always cover exposed skin and wear appropriate

airway protection (e.g. dust mask/respirator) specific to the material used and its application.

7. Anyworkpiece must be appropriately secured before starting a cutting routine by clamps or other practical
securing method. Holding the material by hand or employing any any other unstable form of securing will lead to
unsafe loss of machine control.

8. Cutting bits used for the Mill One should be used at the discretion of the user. Bits are sharp and can crack and
break without notice so appropriate care should be taken by the user while manipulating and installing them.
Carefully check bits for cracks or damage before operating the machine and replace any cracked or unfit bits
immediately.

9. Carefully inspect any consumable material before use on the machine, any unforeseen inconsistency in material
hardness or material quality may cause damage to the machine.

10. Keep away from all moving parts during machine operation.

11. Before beginning a cutting job, ensure the router/trimmer runs properly. Immediately disable the tool if visible
vibration or wobble occurs. This might indicate a damaged tool or an improperly installed bit.

12. Make sure the bit is not contacting the workpiece before the router/trimmer tool is turned on.

13. Do not leave the machine running unattended, the machine should only be operated with the operator present.

14. Do not touch the cutting bit immediately after use. It may be hot and could burn the operator.

15. Use bits that are appropriate to the material and cutting speed used.
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LIST OF
PARTS

1x

2.5
Allen Keys

6 Phillips

F-AC
1x
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STEP 1

Lead Screw , D
Nut Holding ¢
Assembly P-NH A-N M3-8 2.5
3x 3x 12x Allen
SIENCI LABS
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STEP 2

XZ Gantry
Assembly

G-XZ
1x

M5-25
2x

M5-N
2Xx

Allen
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STEP 3

Y Gantry
Assembly e
GY M5-25 M5-N 4
1x 2x 2x Allen
@'
uy ng
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STEP 4

XZ Gantry S @ Q
|
Assembly
VB M5-25 M5-W M5-N M5-NE 4 8mm
4x 4x 4x 2x 2% Allen Wrench
|
|
|
|
|
|
|
| |
| S
Match the eccentric nuts (M5-NE) |
to the larger holes, and the regular @
nuts (M5-N) to the smaller holes
SIENCI LABS
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STEP 5
XZ Gantry & @ ® Q
Assembly
VB M5-25 M5-W M5-N M5-NE 4 8mm
4x 4x 4x 2x 2% Allen Wrench

Match the eccentric nuts (M5-NE) to the larger
holes, and the regular nuts (M5-N) to the smaller
holes
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STEP 6

Y Gantry
Assembly

‘)

VB
4x

M5-25
4x

M5-W
4x

M5-N
2x

&

M5-NE
2x

o A

4 8mm
Allen Wrench

Match the eccentric nuts (M5-NE) to the larger
holes, and the regular nuts (M5-N) to the smaller
holes

H
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STEP 7

Mounting the

Motors to the & ol
Rails M3-8 25
3x 3x 12x Allen

Make sure that the motor connector is facing
downwards
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STEP 8

Mounting the
Motors to the
Rails

©
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STEP 9

Attaching
Z-Lead Screw
to XZ Gantry L5-200 sc )

1x 1x Allen

Make sure to push coupler all the way onto lead
screw before tightening
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STEP 10

Attaching the o Q

Z-Rail to the XZ
Gantry

2 8mm
Allen Wrench

Rotate the eccentric nuts (M5-NE)
until gantry slides onto the rail easily

Make sure to push coupler all the way onto
motor shaft before tightening
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STEP 1

Attaching the

X-Lead screw to d I

the XZ Gantry : 2 8mm
and Calibration 2% 1x Allen Wrench

Rotate the eccentric nuts (M5-NE) to
tighten the grip of the wheels on the rail.
Tighten until you can no longer rotate
the V Groove bearings (VB) with your
fingers.

Make sure to push coupler all the way onto lead
screw before tightening
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STEP 12

Attaching the o Q

X-Rail to the XZ

Gantry ) 8mm
Allen Wrench

Rotate the eccentric nuts (M5-NE)
until gantry slides onto the rail easily

Make sure to push coupler all the way onto
motor shaft before tightening
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STEP 13

Attaching the

Z-Rail to the XZ @" . Q

Gantry and M8-15 6 8mm
Calibration 1x 2% Allen Wrench

Rotate the eccentric nuts (M5-NE) to
tighten the grip of the wheels on the rail.
Tighten until you can no longer rotate
the V Groove bearings (VB) with your
fingers.
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Allen

1x

1x

STEP 15

Attaching Lead
ScrewtoY
Gantry

Make sure to push coupler all the way onto lead

screw before tightening
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STEP 15

Attaching the o Q

Y-Railtothe Y

Gantry ) 8mm
Allen Wrench

Rotate the eccentric nuts (M5-NE)
until gantry slides onto the rail easily

Make sure to push coupler all the way onto
motor shaft before tightening
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STEP 16

Attaching the
Y-Railtothe Y
Gantry

o &

6 8mm
Allen Wrench

Rotate the eccentric nuts (M5-NE) to
tighten the grip of the wheels on the rail.
Tighten until you can no longer rotate
the V Groove bearings (VB) with your
fingers.
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STEP 17

AttachingY 9 .

Gantry to

Frame F-B F-F M8-25 M8-N 6
1x 1x 4x 4x Allen
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STEP 18

Attaching XZ

Gantry to
Frame 6
1x 1x 4x 4x Allen
0
o
o
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STEP 19

Attaching the
Assemblies

@

V@
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STEP 20

Attaching @" o

Frame Brackets

Twist on bolts on all corners loosely,
then tighten on a flat surface
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STEP 21

Attaching @" .
Router Mount
M8-15 6
1 X 2 X A”en
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STEP 22

o | @ o

1x 1x 2x 2x Allen

P-RM router mount fits the Makita
RTO701 router without P-RB bushing,
bushing only required to mount
Ridgid R24012 router
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STEP 23

Attaching
Acrylic Shield
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STEP 24
Combining the
Arduino and
CNC Shield
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STEP 25

Attaching the
Header
Jumpers

E-HJ
6X
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E-C
3x

Motor Cables

STEP 26
Attaching

Make sure the black wire is oriented as depicted
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Stepper Driver

STEP 27
Attaching
Chips
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STEP 28

Tuning the +

Stepper Motor

Drivers Phillips

The stepper drivers should be tuned using the
) potentiometer on the front so that the flat
20 edge on the dial faces to the left; this gives
the stepper motors on the Mill One the right
amount of power to run effectively. If further
tuning is required, turning the flat either

counterclockwise or clockwise will increase
or decrease the motor power respectively.

&

Stepper driver potentiometers should never
be turned while the board is powered up
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Placing Boards
into Electronics

STEP 29
Holder
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E-J

1x

STEP 30

Attaching
DC Jack
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Phillips

STEP 31

Attaching

DC Jack

Ensure polarity is correct to avoid damage to

electronics
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Covering the

STEP 32
Enclosure
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STEP 33

Attaching
Electronics to
Motors
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STEP 34

Assembled
Mill One

y ) 2 < | "?’E,?'"’?T/
R
Nz ‘ @
\ >

Your Mill One is now fully assembled. Don’t plug in your power brick yet, simply

connect the USB cable to your computer and continue onto the next steps.

H
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INSTALLING
FIRMWARE

SIENCI LABS ORDER NOW BLOG RS ABOUT CONTACT =0 ITEMS - $0.00

PUT CNC ON YOUR DESKTOP

VISIT OUR BLOG ORDER NOW

Open your favourite web browser and navigate to the Resources tab of our website.

Resources | SIENCI LABS

S [ E N CI LABS ORDER NOW BLOG RESOURCES ABOUT CONTACT ™0 ITEMS - $0.00

Resources

Hardware:

Software:

CAD/CAM

.

o
Sienci Mill One Facebook Group

n our community of makers on Facebook

Like what we’re doing?

Send us a donation and help grow this project!

On the Resources page, under the Software heading, you should notice a link to the Firmware.
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sienci.com

Sienci Mill One Firmware | SIENCI LABS -+

SIENCI LABS

ORDER NOW BLOG RESOURCES ABOUT CONTACT ™0 ITEMS - $0.00
Ideas into Reality

Sienci Mill One Firmware

The Sienci Mill One uses Grbl 1.7v firmware on an Arduino Uno. The firmware can be flashed onto the

Arduino Uno with the Arduino IDE, Grb default settings for the Sienci Mill One, and by

following the instructions on the Grbl w This version is meant for Mill Ones set up for 1/8

microstepping
Please note that Grbl 1.1v works best with the latest nightly builds of Universal Gcode Sender.

If you are using an Apple computer with the latest OS (10.12 Sierra), you may experience crashes

when plugging in CH340 based Arduino Unos. Please use this drjver if you have trouble connecting
your Arduino to your computer or if you experience these |ssues€%\/md ows users should not have this
problem.
)o@ codeload.github.com [:)
g-ch34g iver: CH340G CH34G CH34X Mac OS X driver +
) i reposir Pull requests Issues  Gist + @~
adrianmihalko / ch340g-ch34g-ch34x-mac-os-x-driver ©Watch~ 18 A Star 153 YFork 19
<> Code Pull requests 1 Projects 0 Pulse Graphs
CH340G CH34G CH34X Mac OS X driver
7 commits 1k Ore 2cc s
: master v New pull request Create new file  Upload files  Find file Clone or download ~

& adrianmihalko committed on GitHub M

est #4 from cotejp/patch-1 [ Clone with HTTPS @
B CHa I " A Use Git or checkout with SVN using the web URL.
E] CH34x_Install_V1.3.pkg
hetps :/ /g1 thub. con/adriannihalko/ch340g-ch | 3

x_Install_V1.3.zip

Open in Desktop Download21P

README.md

ch340g-ch34g-ch34x-mac-os-x-driver

Latest macOS Sierra-compatible driver for devices using the CH340G, CH34G or CH34X chipset. This chipset is used in
several Arduino-clones.

Introduction

If you're using an apple product, your first step will be to download the driver linked on the page.
This will ensure that plugging in your Arduino doesn’t cause any issues.
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[ ] [ ] [ ch340g-ch34g-ch34x-mac-os-x-driver-master L
< E = BIEREDE SRR Q
ch340g-ch34g-ch34x-mac-os-x-driver-master |-
Favorites Name ~  Date Modified size @ Introduction
=) DonDonDon3D = CH34x_Install. s [ 26 KB Destir
ES Photos ' CH34x_Install V1.3.zip Oct 18, 2016, 3:1 78 KB ;
5 Deskiop README.md Oct 18, 2016, 3:16 PM
B Google Drive » ReadMe.pdf Oct 18, 2016, 3:16 PM
Summary
3 Music
E Al My Files
i@ Pictures
[ Documents
© Downloads
Devices
@ Remote Disc
E sace =
Shared
w Loe Erom>a>m> M g-ch34g-ch3dx-mac-os-x-driver-master > @ x_Install_V1.3.pkg
8 intel_ce_linux & I > > @ > 8 > [ ch340g-ch3dg-ch34; dri CH34x_Install_V1.3.pk
1 of 4 selected, 15.49 GB available
& Install CH34x_Install [} Yy s
Installing CH34x_install
@ Introduction « Introduction
& Destination Select N » Destination Select
# |Installation Type # Installation Type
» Installation ing updated o Installation
Summary © Summary

Install time remaining: Less than a minute

4 Install CH34x _Install - a

Welcome to the CH34x_Install Installer

Weicome to CH341 and CH340 usb to serial device driver
installation program

This program instal the driver to the default directory of the system ,
do not change it.

Also this installation only support CH341 and CH340 .

' Install CH34x Install - a

The i ion was

The installation was successful.

The software was installed.

Click Restart to finish installing the software.

—

Once you run the package in the downloaded folder, the driver will install. You will be prompted
to restart your computer, once the restart has completed, you should return to the Firmware
page of our website
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sienci.com

Sienci Mill One Firmware | SIENCI LABS

SIENCI LABS

ORDER NOW BLOG RESOURCES

Ideas into Reality

ABOUT CONTACT = 0 ITEMS - $0.00

Sienci Mill One Firmware
The Sienci Mill One uses Grb v firmware on an Arduino Uno. The firmware can be flashed onto the
Arduino Uno with the A ) IDE, G 1.1v with de It sett for the Si Mill One, and by
following the instructions on the Grbl wiki page. This version is meant for Mill Ones set up for 1/8

microstepping
Please note that Grbl 1.1v works best with the latest nightly builds of

If you are using an Apple computer with the latest 0S (10.12 Sierra), you may experience crashes
when plugging in CH340 based Arduino Unos. Please use this driver if you have trouble connecting
your Arduino to your computer or if you experience these issues. Windows users should not have this

problem.

Back on the Firmware page, you'll want to click to download the “Grbl 1.1v with default settings
for the Sienci Mill One” firmware.

= arduino.org e t

Download the original Arduino software

ARDUINO

Arduino provides an open-source and easy-to-
use programming tool, for w
uploading it to your board. It is ofte
Arduino IDE (Integrated Develo,
If you are new to Arduino and don't know whe
start we have prepared a g

riting code and ARDUINO

IDE ¢

Warning: Use Java 8 with the new Arduino IDE

(=)

PREVIOUS RELEASES

S @),

SOURCECODE

You'll also want to download the latest Arduino IDE onto your computer; select your operating
system to download the appropriate package.
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< = @ arduino.org ©

0ad the original Arduing

ARDUINO

Download

0000

Program your hardware : =

9 Y [ +]o]v]-]

with the Arduino IDE! Genuino
ARDUINO

Arduino provides an open-source and easy-to

use programming tool, for writing code and AN OPEN PROJECT WRITTEN, DEBUGGED,

uploading it to your board. It is often referred to as th SIENUE B TS | BY ) I AN D
THE ARDUINO COMMUNITY WO RLOWIDE

Arduino IDE (Integrated Development Environment

If you are new to Arduino and don't know where

start we have prepared a getting s

the various steps you have to follow ta install Arudinc

LEARN MO RE ABOUT THE CONTRIBUTORS
or [CCETECTIE on arduine.ce/eredits

age with all

08 1080 |48+ O

Ifyou have problems with installing and using the  ~ procop o
software, ask for help in our Arduino forum.
Warning: Use Java 8 with the new Arduino IDE!

® D

PREVIOUS RELEASES SOURCECODE

Open the Arduino IDE once it’s installed

L3

INLOAD ARDUINO

WS INSTALLER

WINDOWS ZIP FILE

LINUX 32 BITS
LINUX 64 BITS
Q=
INUX ARM
CHANGELOG

[O) ¥ 2 o) 6% 1 Mon128AM Andylee Q @

IDE

& Arduino Edit Sketch Tools Help

New #EN 5

< arduino.org
Op #0
Open Recent > Download the original Arduino
Sketchbook >

e Examples > v BUY v
Close ®rW

ARDI  save #S
oy ous skatch_jan23a | Arduino 1.8.1
Page Setup 08P
Print #P sketch_jan23a
0O O ©® 0 oid setup() {

// put your setup code here, to run once:
}

void loop() {
Program your hardware // put your main code here, to run repeatedly:

with the Arduino IDE! }

Arduino provides an open-source and easy-t
use programming tool, for writing code and

uploading it to your board. It is often referred to as|
Arduino IDE (Integrated Development Environme
If you are new to Arduino and don't know wher

start we have prepared a getting sf
the various steps you have to follow to install Arudil
IDE and connect your board to it.

If you have problems with installing and using the
software, ask for help in our Arduino forum.
Warning: Use Java 8 with the new Arduino IDE!

Arduino/Genuino U

S @)

PREVIOUS RELEASES SOURCECODE

Once open, navigate to File-> Open

JLOAD ARDUIN

WINDOWS INSTALLER

2P FILE

LINUX 32 BITS

LINUX 64 BITS

©

CHANGELOG

INUX ARM
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&8 Downloads v

s} [ s =) =-

Favorites @ Arduino
£ DonDonDon3D
7 BN GRBL-v1 »
3 Photos

= Desktop

B Google Drive
-
J1 music

Al My Files

Bm

Pictures
% Documents

o Downloads

Devices
Remote Disc
3 e4ce a

Shared
M intel_ce_linux

Tags

New Folder

[0 GRBL v1.1 Si..ne Firmware
B9 ch340g-ch3..driver-master » [l UniversalGe..er 2.0 Nightly *

il ktof
8 grblUpload
£ grblWrite_Buildinfo

» 9 grbl >

You should find a folder for the GRBL download in your downloads folder. Navigate through the
folders until you find grblUpload.ino, double-click it to openiit.

ARDUINO

Download

void sf

0 0 © 0

1

void I
Program your hardware )xp‘

with the Arduino IDE! |

Arduino provides an open-source and easy-t
use programming tool, for writing code and

uploading it to your board. It is often referred to as{
Arduino IDE (Integrated Development Environmel

If you are new to Arduin

start we have prepared a get rte
the various steps you have to follow t
IDE and connect your board to it.

If you have problems with installing and using the
software, ask for help in our Arduino forum.
Warning: Use Java 8 with the new Arduino IDE!

@

PREVIOUS RELEASES

grblUpload

SOURCECODE

arduino.org

Download the original Arduino softwa

grblUpload | Arduino 1.8.1
skets

ARDUINO IDE
1 s s
WS 2P FILE
JAc 0s
sz
XeamTs

Jux arm

Arduino/Genuino Uno on /dev/c

CHANGELOG

This is the code that needs to be uploaded to the Arduino.
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® Arduino File Edit JETCO) Tools Help ®E 9 Z o) 5% 151 Mon1:29AM Andylee Q @& =
< Verify/Compile %R v
Upload #8U
Upload Using Programmer 038U Download the original Arduino saftwar 4
» Export compiled Binary N®s
Show Sketch Folder K j v v v 1M v ?
ARDUINO Include Library » Manage Libraries...
Add File...
Add .ZIP Liti zary.
DownIoad
E grblUpload | Arduino 1
Bridge
0O 00 0 EEPROM
Esplora
Ethernet
Firmata
HID | i
Program your hardware | Keyboad ARDUINO IDE
Mouse
with the Arduino IDE! Robot Control WS INSTALLER
Robot IR Remote
Arduino provides an open-source and easy: Robot Motor s 2 1.
use programming tool, for writing code and sb
uploading it toyour board. It is often referred to af z::[wareserial ! B
Arduino IDE (Integrated Development Environm SpacebrewYun
If you are new to Arduino and don't know whé  Temboo Bx3zers
start we have prepared a getting started page witl  Wire b
the various steps you have to follow to install Arud z Pxeanirs
IDE and connect your board to it Adafruit Circuit Playground
If you have problems with installing and using the HUX ARM

¢
@
software, ask for help in our Arduino forum. }
f
i

3 N _
Warning: Use Java 8 with the new Arduino IDE! LiquidCrystal
Servo

Stepper
TFT
WiFi

Arduino

S

PREVIOUS RELEASES SOURCECODE CHANGELOG

The last step to prepare for uploading the code is to include the Grbl library. Go to Sketch->
Install Library-> Add .zip Library then navigate back to your downloads folder.

O < EH i@ 25+ |8 Downloads o th Q
Favorites @ Arduino % GRBL v1.1 Si..ne Firmware * [ grbl

E5 DonDonDon3D 9 ch340g-ch3..driver-master » [ UniversalGc...er 2.0 Nightly » grbl.zig

- ™9 GRBL-v1 >

E Photos —

[E] Desktop

5 Google Drive

J7 Music

E Al My Files

i1 Pictures

[S] Documents

€ Downloads
Devices

(@ Remote Disc

L] sacs &
Shared

M intel_ce_linux
Tags

New Folder Cancel

Once again, open the Grbl folder then navigate through and double-click on the grbl.zip file.
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% = arduino.org
ARDUINO
Download
sket
0O 06 0 vl
g grblUpload
}
void Iy
Program your hardware 7/ p

with the Arduino IDE! |

Arduino provides an open-source and easy-t
use programming tool, for writing code and

uploading it to your board. It is often referred to as |
Arduino IDE (Integrated Development Environmel
If you are new to Arduino and don't know wher|

start we have prepared a getting stal
the various steps you have to follow to install Arudil
IDE and connect your board to it.

f you have problems with installing and using the

ed page with|

software, ask for help in our Arduino forum.
Warning: Use Java 8 with the new Arduino IDE!

Updates available for some of your libraries %

S

PREVIOUS RELEASES

N

SOURCECODE

CHANGELOG

ARDUINO IDE

WS INSTALLER

DWS 2P FILE

ACOSX

Ux3281ms

UxeaBITS

NUX aRM

The Arduino IDE should confirm that the Library was added and you will now be able to upload

the code to the Arduino.

& Arduino File Edit Sketch Help
—/| Auto Format
Archive Sketch
Fix Encoding & Reload
Serial Monitor
Serial Plotter

<

WIiFi101 Firmware Updater
Board: "Arduino/Genuino Uno"

ARDUINO

Downloa Port: "/dev/cu, 1421 (

=

o) o5% @@ 1 Mon1:29AM Andylee Q. @

®T

%M

onL

Get Board Info

Programmer: "AVRISP mkil"
Burn Bootloader

0 0 © (¢

Program your hardware /79|
with the Arduino IDE! |

Arduino provides an open-source and easy-t
use programming tool, for writing code and

uploading it to your board. It is often referred to as |
Arduino IDE (Integrated Development Environmel
If you are new to Arduino and don't know wher
start we have prepared a getting sf
the various steps you have to follow to install Arudi|

IDE and connect your board to it.
f you have problems with installing and using the
software, ask for help in our Arduino forum

Warning: Use Java 8 with the new Arduino IDE!

S

PREVIOUS RELEASES

Check in the Tools tab that you've selected your board to be the Arduino Uno.

Boards Manager...

Arduino AVR

Arduino Ydn

SOURCECODE

Arduino Duemilanove or Diecimila

Arduino Nano

Arduino/Genuino Mega or Mega 2560

Arduino Mega ADK
Arduino Leonardo
Arduino Leonardo ETH
Arduino/Genuino Micro
Arduino Esplora
Arduino Mini

Arduino Ethernet
Arduino Fio

Arduino BT

LilyPad Arduino USB
LilyPad Arduino
Arduino Pro or Pro Mini
Arduino NG or older
Arduino Robot Control
Arduino Robot Motor
Arduino Gemma
Adafruit Circuit Playground
Arduino Ydn Mini
Arduino Industrial 101
Linino One
Arduino Uno WiFi

Arduino/Genuino Uno on /dev/cu.usbmodem1421

CHANGELOG

ARDUINO IDE

WS INSTALLER

DS 2P FILE

JAcos x

Bx32 8r7s

x4 BT

fux arm
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& Arduino File Edit Sketch T Help ®HE 9 72 «) 9% @ Bl Mon129AM Andylee Q @

< = Auto Format ®T =
Archive Sketch :
Fix Encoding & Reload {l Arduino softwas n
e Serial Monitor T%M
Serial Plotter o%L L - > o
ARDUINO WiFi101 Firmware Updater

Board: "Arduino/Genuino Uno"
Port: "/dev/cu.usbmodem1421 (Ard

Downloa

/Genuino Uno)" » erial ports

Get Board Info /dev/cu.Bluetooth-Incoming-Port
/dev/cu.BIGJAMBOXbyJawbone-SPPD

o o e ‘ Programmer: "AVRISP mkil"
Burn Bootloader

Program your hardware W ARDUINO IDE
with the Arduino IDE! |; | -
Arduino provides an open-source and easy-t Bszerie
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Also check that the proper port is selected.
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Then click Upload on the IDE to upload the code.
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The IDE should confirm that the code is done uploading.
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To confirm that the code was implemented correctly, go to Tools then open up the Serial Monitor.
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Once you set your baud rate to 115200 you should see that the monitor shows the following
message, this means that the firmware has been uploaded correctly.

Congratulations!

Your Mill One should now be ready to go. In order to start using your machine you should start
becoming comfortable with a CAM software as well as find a program which will send the g-code
to your machine. For our software recommendations, you can navigate back to the Software
heading on the Resources page of our website. For additional resources, be sure to check out our
other hardware resources as well as request to join our user Facebook group where you can ask
guestions, find answers, and interact with the rest of the Sienci community.
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